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Getting Started with AutoDocMail

INTRODUCTION
WHAT IS IT?
The AutoDocMail is a software for automatic emailing of PDF documents. The recipients email
addresses are either extracted from document’s text or assigned either based on user-supplied
“keyword-to-email” or “file name-to email” correspondence table. Each PDF file will be delivered as
an email attachment in a separate email message. There are options to customize email message
text, password protect outgoing files with passwords extracted from document’s text and attach
additional files to each email.

WHEN TO USE IT?
Use this software to automatically email files if you have:
1. Multiple PDF documents that need to be delivered to different recipients.
2. Single PDF document(s) that contains pages that needs to be delivered to different recipients.
Example 1: The software can take multiple PDF files that represent invoices and automatically search
each file for an email addresses (including CC and BCC), if email address is found – email the file to
the recipient.
Example 2: The software can take a single PDF file that contains multiple pay stubs (one page per
stub), automatically split it into separate PDF files and send each file to the email address listed on
each sub-document (pay stub).
Example 3: The software can search PDF file using a set of user-defined search keywords and assign
the corresponding email recipients. Use this method to assign emails based on account numbers,
company names, customer IDs and other similar entities.
The software can only split input PDF document into equal number of pages sub-documents. If you
need to use more sophisticated document splitting technique then use AutoSplit plug-in for Adobe
Acrobat: http://www.evermap.com/AutoSplit.asp.

FUNCTIONALITY OVERVIEW
The AutoDocMail software is designed to perform the following tasks:
•

Automatically mass-distribute PDF documents to recipients whose email addresses
(including “cc” and “bcc”) are contained within the document.

This software allows the user to:
•
•
•
•
•

Automatically search for and extract email addresses from PDF files.
Automatically search for and extract email message subjects from PDF files.
Search for user-defined keywords and assign corresponding email recipients.
Assign email addresses based on the filenames.
Split input documents into set of smaller documents with user-specified number of pages.
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•
•
•

Secure outgoing PDF documents with a password with specific access permissions (editing,
printing, etc.).
Automatically send documents for mass-distribution via email.
Automatically maintain a message log that records date, time, file name, all recipients for
each email message.

After the search and extraction, the user can edit the following for each email message:
•
•
•

Add or remove email recipients.
Modify message subject.
Modify message content.

The software can be used to mass distribute emails via:
•
•

Your current emailing software such as Microsoft Outlook.
SMTP email servers such as Gmail or Hotmail.

SYSTEM REQUIREMENTS
The AutoDocMail is a plug-in for Adobe Acrobat (version 6.0 and up). It requires Windows OS
versions 8, or 10.
Important: this product does not work with free Acrobat Reader, it requires full version of Adobe
Acrobat.
The product information page is located at: http://www.evermap.com/autodocmail.asp.
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DISTRIBUTING PDF DOCUMENTS – BASIC SETTINGS EXAMPLE
DISTRIBUTING PDF DOCUMENTS WITH EMAIL ADDRESSES CONTAINED WITHIN
TEXT
We will demonstrate how to configure AutoDocMail to distribute individual pay stubs originating
from a single PDF file. We begin with a single pdf document containing multiple pay stubs. Each
page of the PDF document contains a pay stub for a recipient whose email address is written on that
page. Here is the first page; recipient’s email is highlighted:

NOTE: The email address does not have to be visible on the page. It can be printed using white font
on white background or be hidden by other page elements.
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1.

To begin, open Adobe Acrobat and select "Plug-ins > Auto-Email Documents..." from the “PlugIns” menu of Adobe Acrobat:

2. Assuming this is our first time using the plug-in for this purpose, we will need to configure the
application preferences. This is a one-time procedure. You can change application preferences
at any time by clicking the “Settings…” button:
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3. The “Manage Settings” dialog will appear on the screen. Click the “New…” button to configure
new settings or double-click on “Default” settings if you want to modify the default settings:

4. The “Email Settings” dialog will appear. Here, under the “Description’ tab, you can change the
Name of the settings and add a Description that describes this particular configuration:

It is possible to password-protect a particular settings configuration to prevent unauthorized use of
the application. Check “Ask for password before processing…” option if necessary.
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5. Click on the “Document Processing” tab, to move to the next level of settings configuration:

6. Select “Split input documents into separate files…” option by clicking the preceding circle. This
option is necessary because we are going to process a single PDF file that contains multiple subdocuments (pay stubs) and each sub-document needs to be emailed separate to a different
recipient.
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7. “Specify the number of pages per individual output file” by typing a number in the box. We type
“1” since each pay stub occupies one page:

8. Check the box preceding “Combine files for each email recipient into a single document”, to
ensure that each recipient receives a single email, in case if there are multiple documents pages
that addressed to the same email address. Do not use this option if there are multiple recipients
of each document or CC/BCC addresses are used.
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9. Check the box preceding “Do not send document with number of pages outside of the following
range, then type “1” in the “Min allowed number of page” and “1” in the “Max allowed number of
pages” as a safeguard to ensure that each recipient receives the correct document.

10. Click on the “Email Setting” tab, to move to the next level of settings configuration:
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11. Select Use Internet E-mail Server (SMTP) by clicking the preceding circle. Make sure the
checkbox preceding “Allow sending multiple documents in a single email” is checked if there
may be multiple files addressed to the same recipient.

12. Click on “Edit Settings” to configure your Internet E-mail Account Settings:

13. Click on your email server listed under “Default Settings” and the application will auto-fill your
email Server Information. If your email server is not listed, you will need to manually enter the
Server Information. Please contact your IT department for exact SMTP server settings used at
your organization.
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14. Fill in your User Name and Password under “Logon Information”, then Your Name, E-mail
Address and Reply-To E-mail Address under “User Information”:

15. Click “Test Account Settings” to make sure e-mail server settings were configured correctly:
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16. Click “Yes”:

17. The following screen should appear if the application successfully connected to the server. Click
“OK”:

NOTE: If you receive an error message, and your login information is correct, you may need to
go into your Gmail account and manually allow the application access into your account. To see
if this is the case, simply check your Gmail e-mail and look for a message from Google notifying
you of “a sign-in from a less secure app”. That email should provide directions on how you can
allow the application access.
18. If you are wanting to send e-mails to 100 recipients or more, you should configure the
application to pause between sending emails. This action prevents your e-mails from being
labeled as spam and your sending ability from being temporarily deactivated by your email
service provider. Select the number of seconds you would like the application to pause from the
drop-down menu (5 seconds is recommended for 500 or more recipients):
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If you are planning to send a large number of emails, then please contact your email service
provider to make sure you will not exceed a daily email quota and avoid spam filters.
Click “OK”:

19. Click on the “Default Message Settings” tab, to move to the next level of settings configuration:
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20. Type the text for the message Subject and body Message for all outgoing emails in the
appropriate space. You can also specify TO, CC, and BCC recipients, who will always receive a
copy of each email.

21. Click on the “Email Extraction” tab, to move to the next level of settings configuration:
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22. This is an advanced settings page, which supports various text-recognition features. The
application can recognize and extract information from within the document text. For example, if
you check the box for “Search for CC recipients,” you can specify a CC recipient within the text
using the keyword “CC:” followed by the email address; the application will then recognize and
extract the CC information for each document. The plugin supports other keywords, such as
“BCC,” “Subject,” Filename,” and “Greeting.” Please see the Advanced Settings section of this
guide below for more information on these settings.

23. Unless you require advanced settings, you do not need to modify anything in the “Email
Extraction” tab, or the “Security” tab (See Advanced Settings below for help with these settings).
Click “OK” to finish settings configuration:
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24. Click “Close” to finish settings configuration and proceed to processing your documents.

25. The "Auto-Email Documents" dialog will appear on the screen. Click the "Add Files..." button to
select the source PDF file that needs to be distributed:
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26. Select one or more input files in the “Open” dialog, then click “Open”:

27. Click “Next >”.

28. Once your document is split and processed, you will see the “Confirm Email Recipients” screen,
which will list the extracted information for each recipient. Each recipient’s e-mail address,
Subject, and Attachment for each message should be listed. A green preceding circle indicates
successful processing. Double-click on any record in the list to preview the document and/or
17 | P a g e

Getting Started with AutoDocMail
modify the e-mail settings:

NOTE: The application creates temporary files when splitting the single large document into
smaller documents. The attachment pathways listed on this screen reflect these temporary files,
which will be deleted once processing is complete.
29. You can review each attachment. To modify the recipients (TO, CC, BCC), Subject, and Message
content of each e-mail by click on “Edit Email Settings”:
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The Subject and Message that appears in this window is the default that we defined in
“Settings” at the beginning of this tutorial. You can modify all fields for each message by typing
in the appropriate boxes; click “OK” when finished:

30. You can control which recipients will receive e-mails, as only those recipients with a checkmark in
the box preceding their e-mail address will receive e-mails. Once you have reviewed and are
satisfied with the mass-mailing arrangement, click “Send”:
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31. Click “Yes” to start emailing documents.

32. The “AutoDocMail Plug-in- Processing Documents” window will pop-up on the screen indicating
the processing progress. This window will disappear once mass-distribution of all documents is
complete.

33. The “Auto Email Documents” window will tell you how many total emails were sent and will
inform you of whether the operation was successful or if any errors were experienced during emailing. Click “OK” to finish:
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ADVANCED SETTINGS
ADVANCED FUNCTIONALITY OVERVIEW
The AutoDocMail software can optionally perform the following advanced tasks:
•
•

Automatically email PDF documents to the recipients based on custom keyword search.
Automatically email PDF documents to the recipients whose email addresses are contained
within a custom filename-to-email address map.

This software allows the user to set up the following security features:
•
•
•

Secure settings configurations with a password to restrict usage of those settings.
Secure outgoing PDF documents with a document “open” password.
Secure outgoing PDF document with document access password and restrictions.

This software can extract email addresses (including “cc” and “bcc”) and email message subjects from
PDF files’:
•
•
•

Text
Annotations
Properties

USING KEYWORDS-TO-EMAILS MAPPING TABLE
Many business documents do not contain email addresses as part of the document content. If you
are wanting to send documents that do not contain recipients’ email addresses within the text, but
you do have unique keywords that can be directly associated with email addresses, then you can
create a custom keywords-to-email address map. This method allows you to manually assign email
addresses of the recipients based on presence of the specific search keywords. For example, use this
method to assign emails based on account numbers, customer IDs, SSNs, company names and
other similar items. This method is suitable for the cases when documents are regularly emailed to
the same group of recipients.
The keyword-to-email mapping table is defined as a series of comma-delimited text lines. The
search keyword is followed by the corresponding email address:
ACME SYSTEMS, orders@acmesystems.com
ABCD LABS, invoices@abcdlabs.com
PACIFIC SHIPPING, invoices@pacificshiping.com
“FOREST PRODUCTS, INC.”, invoice@forestpr.com;maryann@forestpr.com
If the search keyword contains one or more commas, then it needs to be surrounded with quotation
marks. The input documents are searched for the keywords, and email addresses are assigned
based on the successful matches. This method is only applicable for the “mail-to” email addresses
and cannot be used for CC and BCC.
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Use the instructions below for configuring a keyword-to-email mapping.
1.

Open the AutoDocMail plug-in by selecting "Plug-ins > Auto-Email Documents..." from the
Plug-in menu of Adobe Acrobat:

2. Click the “Settings…” button:
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3. The “Manage Settings” dialog will appear on the screen. Select the settings configuration that
you wish to edit, then click the “Edit” button:

4. Click on the “Email Extraction” tab:
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5. Select “Use keyword-to-email address mapping” option and press “Map Keywords To E-mails”
button:

6. Type the search keyword, followed by a comma, followed by the email address of the
corresponding recipient (one keyword per line). Separate multiple email addresses with a
semicolon if it is necessary to specify more than one email. Press OK button once done.
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TIP: If a file name contains a comma character, then surround file name with quotation marks:
“Forest Products, Inc.”, john.doe.@mycompany.com.
Optionally, you can specify additional email parameters such as “Subject”, “CC”, “BCC”, “Filename”,
“Greeting”, “From”, “Replyto”. For example, use the following syntax to add a subject line, a custom
greeting and CC email address to the email mapping table:
"John Doe Junior", invoices@acme.com|subject:Enter a custom subject line|greeting:Dear John Doe
Junior|cc:info@acme.com
7. Click “Close” to finish settings configuration and proceed to processing your documents.

USING CUSTOM FILENAME-TO-EMAIL MAPPING TABLE
If you are wanting to send documents that do not contain recipients’ email addresses within the text,
but you do have unique filenames that can be directly associated with email addresses, then you can
create a custom filename-to-email address map. This method allows you to manually assign email
addresses of the recipients you wish to receive particular documents.
1.

Open the AutoDocMail plug-in by selecting "Plug-ins > Auto-Email Documents..." from the
Plug-in menu of Adobe Acrobat:
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2. Click the “Settings…” button:

3. The “Manage Settings” dialog will appear on the screen. Select the settings configuration that
you wish to edit, then click the “Edit” button:
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4. Click on the “Email Extraction” tab:

5. Click on the box preceding “Use custom filename to email address mapping” and press “Map
Filenames to E-mails” button:
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6. Type the filename, followed by a comma, followed by the email address of the corresponding
recipient. Each line should contain only one filename and its recipient/s. If you need to specify
more than one recipient per filename, then separate the email addresses with a semicolon:

TIP: If a file name contains a comma character, then surround file name with quotation marks:
“paystub, John Doe.pdf”, john.doe.@mycompany.com.
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Optionally, you can specify additional email parameters such as “Subject”, “CC”, “BCC”, “Filename”,
“Greeting”, “From”, “Replyto”. For example, use the following syntax to add a subject line, a custom
greeting and CC email address to the email mapping table:
JohnDoe.pdf, invoices@acme.com|subject:Enter a custom subject line|greeting:Dear John Doe
Junior|cc:info@acme.com
It is possible to enter one or more optional keywords separated by the | symbol. Keyword names are
case-insensitive.
Click “OK” to finish entering filename-to-email mappings.
7. Click on the “Document Processing” tab:
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8. Click on the circle preceding “Send input documents ‘as is’…”:

9. Make sure that the box preceding “Do not send documents with number of pages outside of the
following range” is unchecked:

The above settings are necessary because we are sending documents based on file name to email
mapping table. This means that a whole document needs to be emailed to each recipient.
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10. Click on “Email Setting” tab:

11. Click the box preceding “Send separate emails to each recipient...” to ensure that recipients who
are mapped to the same filename receive separate emails:

Click OK button to close settings dialog.
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12. Click “Close” to finish settings configuration and proceed to processing your documents.

13. The "Auto-Email Documents" dialog will appear on the screen. Click the "Add Files..." button to
select the source PDF file that needs to be distributed:

14. Select one or more input files in the “Open” dialog, then click “Open”. Make sure that you are
selecting files that actually exist in the file name-to-email mapping table.
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15. Click “Next >”:

16. You will see the “Confirm Email Recipients” screen, which will list the recipients and
corresponding attachments for each recipient. Each recipient’s e-mail address, Subject, and
Attachment for each message should be listed. Double-click on any record in the list to preview
the document and/or modify the e-mail settings (this is not necessary, but recommended to
verify that document is assigned to the correct recipient):
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17. You can optionally review each attachment. To modify the recipients (TO, CC, BCC), Subject, and
Message content of each e-mail by click on “Edit Email Settings”:

18. The Subject and Message that appears in this window is the default that we defined in
“Settings” at the beginning of this tutorial. You can modify all fields for each message by typing
in the appropriate boxes; click “OK” when finished:
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19. You can control which recipients will receive e-mails, as only those recipients with a checkmark in
the box preceding their e-mail address will receive e-mails. Once you have reviewed and are
satisfied with the mass-mailing arrangement, click “Send”:

Optionally, use “Copy Unchecked Files” button to copy attachments from all unchecked emails
into a separate folder for later processing or review.
20. Click “Yes” to start emailing documents:
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21. The “AutoDocMail Plug-in - Processing Documents” window will pop-up on the screen indicating
the processing progress. This window will disappear once emailing of all documents is complete.

The final confirmation dialog will be shown on screen once processing is finished. It will list the
total number of email sent and any warning or errors that occurred during the processing. If
there are no errors, the “Operation has been completed successfully” message will appear in the
window. Click “OK” to close the dialog. The processing is completed:
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PASSWORD PROTECTING OF PROCESSING SETTINGS
It is often necessary to restrict usage of the AutoDocMail to only authorized members of staff.
The AutoDocMail provides a way to password protect a specific settings configuration. The user
will be required to enter a password in order to use the protected settings and actually email
documents.
1.

Open the AutoDocMail plug-in by selecting "Plug-ins > Auto-Email Documents..." from the
Plug-in menu of Adobe Acrobat:

2. Click the “Settings…” button:
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3. The “Manage Settings” dialog will appear on the screen. Select the settings configuration you
want to edit and click the “Edit…” button.

4. Under the Description tab, click on the checkbox preceding “Ask for password before processing
documents or accessing these settings”. Enter a password. Re-enter the same password again.
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CUSTOMIZING EMAIL MESSAGE AND SUBJECT LINE BY TEXT SEARCH
It is possible to extract a piece of text from the document’s text and use it anywhere in the subject
line or within a message body. Any text enclosed within ##....## is treated as a search expression.
You can use search expressions in the “Subject” and “Message” email fields only. Search expressions
are using regular expression syntax and can be used to extract text patterns such as account
numbers, social security numbers, email addresses and virtually any other text that contains a
certain unique keyword or a pattern. A regular expression (shortened as regex or regexp) is a
sequence of characters that specifies a search pattern. Usually, such patterns are used by stringsearching algorithms for "find" or "find and replace" operations on strings, or for input validation.
Regular expressions are used in search engines, search and replace dialogs of word processors and
text editors, in text processing utilities. There are countless tutorials available online with copious
examples. Here is one of the good websites: https://www.regular-expressions.info/tutorial.html.
Each search expression that occurs in the subject or email message body will be replaced with a
matching text extracted from the document. If there is no text that matches the expression, then it
will be replaced with “nothing” and essentially removed from a subject line or a message body.
Search expressions using in AutoDocMail are case-sensitive.
The following example extracts the greeting line from the document and uses it to start an email
message to produce a customized text that is in sync with the document being emailed:
##^Dear [^\n]+##,
Please find your monthly statement for the ##account: \d{10}##.
The above example contains two search expressions:
•
•

^Dear [^\n]+ - this expression looks for the text line that starts with "Dear" and extract all
text until end of the line.
account: \d{10} - this expression searches for word "account:" that is followed by a space and
a 10-digit number.

The above example will produce the following sample output:
Dear John Doe,
Please find your monthly statement for the account: 7539539539.
Here is a short list of useful regular expressions (please see online tutorial for complete syntax):
\d – stands for a single digit.
\d+ - stands for one or more digits.
\w – stands for a single “word character” that is either a digit, letter or underscore.
[A-F] – matches a single letter from A to F: (A, B, C, D, E, F).
[\d,.]+ - matches one or more digits, commas or periods. Useful for matching amounts.
\d{3}-\d{2}-\d{4} – matches a social security number (for example 123-45-6789).
\b\d{10}\b – matches a 10 digit number that is not part of any larger number
\d{4,6} – matches a number between 4 and 6 digits
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SECURING PDF DOCUMENTS
Optionally, secure outgoing PDF documents with a "document open" and "user permission"
passwords. Recipients will be required to enter a "document open" password in order to view its
content. The content of the PDF file is going to be encrypted and cannot be read unless unlocked
with a correct password. The best passwords are random and strong enough to thwart a brute force
or dictionary attack. Use combination of lower and upper case letters, digits, and symbols
(@,!#$%^&*!) to create strong passwords. Avoid using short passwords. The reliable password
should be at least 8 characters long.
The AutoDocMail provides 4 different methods for securing outgoing documents:
1. Use a single "global password" for all outgoing documents.
2. Extract document-specific passwords from the text content using "Password" keyword (for
example: password: abc123).
3. Assign document-specific passwords by using user-supplied keyword-to-password mapping
table. Use this method to assign passwords based on account numbers, EINs, SSNs, phone
numbers, emails and etc.
4. Extract document-specific passwords from document's metadata properties (use custom
"Password" property).
The methods #2 and #3 are the most commonly used and provide a large degree of flexibility.
Use method #2 (“Password” keyword) to embed the password right into the PDF document. The
AutoDocMail will automatically detect the password and use it to secure the file. The password
keyword can be placed anywhere on the page, it can be hidden or printed with white font on white
background to make it invisible for the user (however, it will be still possible to find it on the page).
Use method #3 (Keyword-to-Password mapping) when it is not desirable to put passwords into the
PDF documents or PDF documents are already generated and it is not possible to modify them. This
method allows to associate unique text or numbers with a password. For example, use this method
to assign passwords based on social security or account numbers. The AutoDocMail will search each
document for the user-supplied keywords (SSNs for example) and assign passwords based on the
search results. This method does not require any modifications to the PDF documents and is
probably the most flexible method for securing the documents.
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SECURE OUTGOING DOCUMENTS WITH A PASSWORD EXTRACTED FROM TEXT
Use this method to secure each outgoing PDF document with a password that is extracted from a
keyword search of the input PDF document. The recipient will need to enter their password in order
to open the e-mail attachment in Adobe Acrobat or any other PDF viewer.
1.

You will first need to specify passwords within your input PDF document, using the “Password:”
keyword. Here is the same input document that we used for our Basic Settings example. This is a
multipage PDF document that contains a pay stub for a different recipient on each page. Here is
the first page of the PDF document with the password within the text:

NOTE: The password does not have to be visible on the page. It can be printed using white font on
white background or be hidden by other page elements.
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2. Open the AutoDocMail plug-in by selecting "Plug-ins > Auto-Email Documents..." from the
Plug-in menu of Adobe Acrobat:

3. Click the “Settings…” button:
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4. The “Manage Settings” dialog will appear on the screen. Click the “New…” button to configure
new settings, or, to edit an existing settings configuration, select the settings configuration you
want to edit and click “Edit…” button:

5. Click on the “Security” tab:
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6. Check the box preceding “Secure all e-mailed documents with passwords” and select “Use
‘Password:…’ text keyword” from the drop-down menu.

There are 3 other options available for selecting a document password:
- Using a “Global” password for all outgoing documents. Use this option to specify a single
password for all documents.
- Using “Password” document property to choose a password. PDF document properties can be
set via “File > Properties” dialog in Adobe Acrobat in “Custom” tab. Use this method to assign
individual passwords to PDF documents without placing a password into document’s text.
- Using Filename-to-Password table. Use this method to assign passwords based on the file
name. Press “Assign Passwords to Files” button to enter filename-to-email mappings.
Examples of the “password” keyword usage:
Document’s Text
Password: sajhg32732AB
Use password: ABC193, cc:user@myweb.com
password: aBcDeF mailto:user@myweb.com
password: 12-23_45; some text here

Password extracted
sajhg32732AB
ABC193
aBcDeF
12-23_45
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7. Click “OK” to close settings dialog:

NOTE: If you need assistance with settings configuration, please see the first part of this Guide,
which details basic functionality.
Click “Close” button to close “Manage Settings” dialog:
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8. The "Auto-Email Documents" dialog will appear on the screen. Click the "Add Files..." button to
select the source PDF file that needs to be distributed:

9. Select your input file (from Step 1) in the “Open” dialog, then click “Open”:
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10. Click “Next >”.

11. Once your document is processed, you will see the “Confirm Email Recipients” screen, which will
list the extracted information for each recipient. Click on the checkbox preceding “Show
Passwords…” to expand the document parameters listed on the screen to display the extracted
passwords. You can scroll through the parameters using the scroll bar near the bottom of the
screen. You can now double-click on any record in the list to preview the document and/or
modify the e-mail settings:
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12. Click “Send” to begin emailing the password protected documents:

13. The final confirmation dialog will be shown on screen once processing is finished. It will list the
total number of email sent and any warning or errors that occurred during the processing. If
there are no errors, the “Operation has been completed successfully” message will appear in the
window. Click “OK” to close the dialog. The processing is completed:
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SECURE OUTGOING DOCUMENTS USING KEYWORD-TO-PASSWORD TABLE
This method allows to associate unique text or numbers with a password. For example, use this
method to assign passwords based on social security or account numbers. The AutoDocMail will
search each document for the user-supplied keywords (SSNs for example) and assign passwords
based on the search results. This method does not require any modifications to the PDF documents.
You can configure passwords for this method on the “Security” tab in the “Email Settings” dialog.
1. Check “Secure all e-mailed documents with passwords” option.
2. Set “Password to use” menu to “Use Keyword-to-Password mappings” method.
3. Press “Map Keywords to Passwords…” button to open a password editor.
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4. Enter keywords (for example, social security or account numbers) and corresponding passwords
into “Mapping” window. Separate keyword and password using comma. Do not use comma in the
keyword or in the password. Each keyword-password pair should appear on a separate line. For
example, type the following text to associate 3 different social security numbers with passwords:
507-12-3456, pwd19793279bkj$$
558-98-7654, ffAAjjfh8480_@@@
654-01-3456, GHBDO847565!@

You can save the password mapping into a text file by pressing “Save To Text File…” button. You will
be prompted to select a filename and location where to save the keyword-to-password list.
The keyword-to-password mappings can be loaded back from the text file by pressing “Load From
Text File” button. It is possible to use other applications such as Microsoft Excel to prepare the
mappings and then save the spreadsheet in CSV (comma separated values) text format. The CSV files
can be read directly into AutoDocMail.
Alternatively, you can copy/paste text into the “Mapping” window by using standard Windows
keyword shortcuts: use Ctrl+C to copy selected text in another text editor or application, use Ctrl+V
to paste the text into the AutoDocMail.
5. Press OK button to save the mappings and continue with the rest of the settings.
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AUTODOCMAIL PROCESSING KEYWORDS
The AutoDocMail uses a number of special keywords to extract different information from PDF
document’s text. Here is table of keywords used:
Keyword

Usage

to:

Indicates mail-to email address. Any word that ends with to: is treated as this keyword. For
example: to:john@mycompany.com

mailto:

indicates mail-to email address, for example: mailto:john@mycompany.com

mail: or
email:

Indicates mail-to email address. Any word that ends with mail: is treated as this keyword.
Examples: E-mail, email, mail and etc. For example: mail:john@mycompany.com
or email:john@mycompany.com

from:

Indicates an email address to show on “From” field of the email. For example:
from:info@mycompany.com. Overwrites the default settings

reply:

Indicates a reply-to email address to use for the current email. Overwrites the default settings.
For example: reply: sales@mycompany.com

att: or attn:

Indicates mail-to email address (see the previous keyword), for example:
att:john@mycompany.com

cc:

indicates CC email address, for example: cc:john@mycompany.com

bcc:

indicates BCC email address, for example: bcc:john@mycompany.com

subject:

indicates a custom email subject line, for example: subject: Newsletter

filename:

indicates a custom name for the attached document: filename: CustomName.pdf

greeting:

indicates a greeting line that should be used as a first line of the email message

password:

indicates a custom password for the attachment: Password: ABCDE12345

Please refer to software help documentation for more details. You can access documentation via “Help >
Plug-in Help > AutoDocMail” menu in Adobe Acrobat or via any “Help” or “?” buttons on AutoDocMail
dialogs.
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TROUBLESHOOTING
The AutoDocMail maintains a processing log that lists all emails and documents processed. In case of emailing
errors, detailed information can be found in the log by pressing “View Log” button located in the bottom-right
corner of the main screen:

Most of the email errors are results of incorrect SMTP server configuration or due to user-permissions
assigned to computer/email account by your IT department. We suggest to contact your IT department with
all questions regarding email account configuration. They should be able to provide you with correct settings.
Here is an example of the processing log:
1: LOG STARTED: 13/7/2016 , TIME: 6:48:43
2: Number of input documents: : 2
3: Sending file : C:\Users\Admin\AppData\Roaming\EverMap\AutoDocMail\TempFiles\Copies\PayStubSampleDoc1.pdf to
mary.smith@evermap.com via MAPI EX
4: Time: 07/15/16 08:13:27, File C:\Users\Admin\AppData\Roaming\EverMap\AutoDocMail\TempFiles\PayStubSampleDoc1.pdf has been
emailed TO: mary.smith@evermap.com, CC: , BCC: , Subject: Enter Email Subject
5: Sending file : C:\Users\Admin\AppData\Roaming\EverMap\AutoDocMail\TempFiles\Copies\PayStubSampleDoc2.pdf to
john.doe@evermap.com via MAPI EX
6: Time: 07/15/16 08:13:27, File C:\Users\Admin\AppData\Roaming\EverMap\AutoDocMail\TempFiles\PayStubSampleDoc2.pdf has been
emailed TO: john.doe@evermap.com, CC: , BCC: , Subject: Enter Email Subject
7: Number of emails sent : 2
8: Number of documents failed or skipped : 0
9: LOG STOPPED: 17/7/2016 , TIME: 9:16:15
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